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						warsztaty
					
				

			

			
				
					
						umarłych
					
				

				
					
						Do namalowania tej ilustracji użyłem pędzli, które każdy może znaleźć 
					
				

				
					
						w podstawowym zestawie Photoshopa. Chciałem pokazać, że wymyślne 
					
				

				
					
						pędzle, których setki możemy znaleźć w internecie, nie są najważniejsze. 
					
				

				
					
						Ważne jest, jak użyjemy wyobraźni... i kilku Photoshopowych sztuczek.
					
				

			

			
				
					
						tworzenie postaci dark fantasy
					
				

			

			
				
					
						0
						1
					
				

			

			
				
					
						tło i kolory
					
				

				
					
						Cały obraz maluję
						 Pędzlem 
						(
						Brush Tool
						)
						 
						[
						B
						]. Z menu pędzla [
						F5
						] 
					
				

				
					
						wybieram pędzel z postrzępionymi krawędziami o dużym rozmia-
					
				

				
					
						rze. Maluję swobodnie, chaotyczne kształty są jak najbardziej na miej-
					
				

				
					
						scu. Aby uzyskać ciekawsze efekty, manipuluję opcjami 
						Scattering 
					
				

				
					
						i
						 Spacing 
						w menu ustawień pędzla.
						 
						Przesuwam suwaki aż do uzyska-
					
				

				
					
						nia zadowalających efektów. W tej pracy użyłem nienasyconych brą-
					
				

				
					
						zów, które dobrze pasują do malowanej postaci i tworzą ponury klimat. 
					
				

				
					
						Jaśniejsza plama koloru na środku 
						płótna 
						pozwoli na uzyskanie dodat-
					
				

				
					
						kowego efektu trójwymiarowości. Maluję w oddaleniu około 30%.
					
				

			

			
				
					
						inne warianty kolorystyczne
					
				

				
					
						Jeżeli nie jesteśmy pewni czy użyte kolory są dobrze dobrane, 
					
				

				
					
						zawsze możemy szybko sprawdzić inne warianty kolorystyczne. 
					
				

				
					
						Służy do tego menu edycji barw obrazu (Image>
						Adjustments>Hue\
					
				

				
					
						Saturation
						). Przesuwamy suwaki i sprawdzamy, czy któraś z innych 
					
				

				
					
						wersji kolorystycznych nie pasuje przypadkiem lepiej do nasze-
					
				

				
					
						go obrazu. Różne kolory tworzą odmienne nastroje, co może nadać 
					
				

				
					
						naszej postaci dosyć nieoczekiwany i zaskakujący wygląd. Ja po 
					
				

				
					
						sprawdzeniu innych wersji, stwierdziłem, że oryginalne kolory naj-
					
				

				
					
						lepiej pasują do mojego nieumarłego.
					
				

			

			
				
					
						0
						2
					
				

			

			
				
					
						postać
					
				

				
					
						Początek malowania postaci to najważniejsze etapy tworzenia 
					
				

				
					
						obrazu. Maluję pojedyncze plamy i staram się szukać w nich 
					
				

				
					
						kształtów (to dobry sposób, jeżeli nie mamy pomysłu na postać). 
					
				

				
					
						Używam kolorów z tła i 
						Próbnika kolorów
						 (
						Brush Tool - 
						przytrzymu-
					
				

				
					
						jemy klawisz [
						Alt
						] i klikamy na interesującym nas fragmencie). Bar-
					
				

				
					
						dzo ostrożnie dodaję plamy światła, na tym etapie są one tylko tro-
					
				

				
					
						chę jaśniejsze od cieni i służą zaznaczeniu głównych elementów po-
					
				

				
					
						staci. Pracuję w przybliżeniu 50%.
					
				

			

			
				
					
						postać cd.
					
				

				
					
						Powoli zaczynam dodawać mocniejsze światła (użyłem kolorów 
					
				

				
					
						z jasnej plamy z tła). Planując kolejne elementy stroju, tworzę 
					
				

				
					
						nową warstwę i na niej rysuję mniejszym pędzlem kontury pance-
					
				

				
					
						rza nóg oraz fałdy na płaszczu. Ten sposób pozwala dodawać zmia-
					
				

				
					
						ny bez utraty poprzedniego wyglądu pracy. Możemy sprawdzić, któ-
					
				

				
					
						ra wersja bardziej nam odpowiada, klikając 
						oczko
						 przy miniaturce 
					
				

				
					
						warstwy.
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						król 
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						0
						4
					
				

			

			
			
			
			
			
			
			
			
			
			
			
			
			
			
			
			
			
			
			
			
			
			
			
			
			
			
			
			
			
			
			
			
			
			
		

		
			
				
					
						król umarłych – tworzenie postaci dark fantasy
					
				

			

			
				
					
						poziom 
						trudny
						 |
					
					
						 pliki na DVD
					
				

				
					
						Photoshop CS4
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						warsztaty
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						5
					
				

			

			
				
					
						dodatkowe kolory
					
				

				
					
						Na tym etapie stwierdziłem, że postać jest zbyt jednolita ko-
					
				

				
					
						lorystycznie, więc dodałem kolejny kolor – turkus. Użyłem go 
					
				

				
					
						do namalowania światła bijącego z rozdartej klatki piersiowej nie-
					
				

				
					
						umarłego. Światło namalowałem na osobnej warstwie, a następnie 
					
				

				
					
						sprawdziłem czy inne warianty kolorystyczne nie będą lepiej paso-
					
				

				
					
						wać (znów 
						Image>Adjustments>Hue\Saturation
						). Przesuwając su-
					
				

				
					
						waki, doszedłem do wniosku, że kolor zielony lepiej pasuje do mo-
					
				

				
					
						jej postaci. 
					
				

			

			
				
					
						dłonie i twarz
					
				

				
					
						To te dwa elementy sprawiają, że postać zyskuje coś, co można na-
					
				

				
					
						zwać osobowością. Dlatego na nich powinno się skupiać uwagę. Na 
					
				

				
					
						potrzeby mojej postaci namalowałem dłonie kościste, powykręcane, po-
					
				

				
					
						kryte siatką wystających żył. Oczodoły czaszki są węższe po zewnętrz-
					
				

				
					
						nej stronie czaszki, co nadaje nieumarłemu smutny wygląd. Jako że na 
					
				

				
					
						tych dwóch elementach widz skupia największą uwagę, należy je dopra-
					
				

				
					
						cować. Używam małego pędzla do namalowania żył, małych plamek i in-
					
				

				
					
						nych detali. Jeżeli namalowanie dłoni sprawia Wam trudności, poszukaj-
					
				

				
					
						cie zdjęć w internecie albo wzorujcie się na swoich własnych dłoniach.
					
				

			

			
				
					
						0
						6
					
				

			

			
				
					
						faktura zbroi
					
				

				
					
						Kolejnym etapem będzie nakładanie faktury na metalowe ele-
					
				

				
					
						menty stroju postaci. Na początek dużym pędzlem zazna-
					
				

				
					
						czam fragmenty oświetlone i pozostające w cieniu (nie dodaje moc-
					
				

				
					
						nych świateł). Następnie wybieram mały, okrągły pędzel o 
						Kryciu 
					
				

				
					
						(
						Opacity
						) około 60% i zaczynam malować chaotyczne kreski, o róż-
					
				

				
					
						nej długości i kierunku, mieszając w ten sposób kolory. Pilnuje po-
					
				

				
					
						łożenia świateł i cieni. Następnie takim samym pędzlem nakładam 
					
				

				
					
						mocne światła (maluje w ten sam sposób, jednak kreski są drobniej-
					
				

				
					
						sze). Malując tą techniką, przybliżam obraz do około 200%.
					
				

			

			
				
					
						biżuteria i zdobienia
					
				

				
					
						Nie jestem zadowolony z elementów biżuterii, więc na nowej war-
					
				

				
					
						stwie tworzę nowy projekt. Zaczynam od prostych kształtów i po-
					
				

				
					
						woli dodaję szczegóły. Wykorzystuję motyw zdobiący koronę, aby 
					
				

				
					
						ozdoby wyglądały bardziej spójnie. Do namalowania kolczyków uży-
					
				

				
					
						wam zielonego koloru z klatki piersiowej nieumarłego. Dodaję dodat-
					
				

				
					
						kowe zdobienia do korony. Nie jestem zadowolony z efektów i docho-
					
				

				
					
						dzę do wniosku, że najlepszym rozwiązaniem będzie połączenie oby-
					
				

				
					
						dwu wersji biżuterii. Dodaję zielone klejnoty do bransolet na ramionach. 
					
				

				
					
						Jeszcze raz wykorzystuję motyw z korony, tym razem na mieczu. 
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						7
					
				

			

			
				
					
						lustrzane odbicie
					
				

				
					
						Ludzkie oko ma niekorzystną dla artysty skłonność do przy-
					
				

				
					
						zwyczajania się do obrazu, co powoduje, że łatwo przeoczyć 
					
				

				
					
						błędy na tworzonym obrazie. Dlatego dobrze jest obracać obraz wo-
					
				

				
					
						kół jego osi, aby wyłapać ewentualne potknięcia 
						Image>Rotate Ca-
					
				

				
					
						nvas>Flip Canvas Horizontal
						. Po wykonaniu tej operacji widzę, że le-
					
				

				
					
						wa strona płaszcza jest zbyt mało widoczna, wiec na osobnej war-
					
				

				
					
						stwie domalowuję kontury dodatkowej fałdy. Zauważyłem też, że 
					
				

				
					
						światła na czaszce nie zgadzają się z kierunkiem padania promieni.
					
				

			

			
				
					
						miecz
					
				

				
					
						Naszkicowana wersja miecza okazała się krzywa, poprawiam 
					
				

				
					
						ją 
						Rectangular Marquee Tool 
						[
						M
						]. Rysuję prostokąt zawierający 
					
				

				
					
						w sobie miecz. Wybieram 
						Brush Tool 
						[
						B
						] i na nowej warstwie malu-
					
				

				
					
						ję obszar prostokąta - otrzymuję idealnie prostą bazę do namalowa-
					
				

				
					
						nia miecza. Dodaję linię biegnącą przez środek ostrza (przytrzymu-
					
				

				
					
						jąc klawisz [
						Shift
						]). Domalowuję elementy zdobień i zaczynam do-
					
				

				
					
						dawać światła. Tym razem maluję kreski równoległe do linii ostrza. 
					
				

				
					
						Koniec miecza rozmywam kolorami tła.
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						0
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						drobne detale
					
				

				
					
						Dodaję pasy na brzuchu postaci oraz między płytami pancerza 
					
				

				
					
						nóg. Dużym pędzlem wykańczam tło. Dodaję brosze przy na-
					
				

				
					
						ramiennikach. Małym pędzlem o dużym kryciu domalowuję drobne 
					
				

				
					
						detale jak żyły, rysy, pęknięcia metalu. Na sam koniec, spłaszczam 
					
				

				
					
						obraz (
						Layer>Flatten Image
						)
						. 
						Kopiuję powstałą warstwę, wybieram 
					
				

				
					
						narzędzie Pędzel [
						B
						] w trybie 
						Color Dodge, 
						zaznaczam funkcję aero-
					
				

				
					
						grafu,
						 
						próbnikiem wybieram ciemny kolor. Delikatnie maluję światła 
					
				

				
					
						i półcienie, dodatkowo je 
						wypychając
						. Wybranie ciemnego koloru po-
					
				

				
					
						zwoli na delikatniejsze wydobycie świateł, bez efektu przepalenia. 
					
				

			

			
				
					
						ostatnie poprawki
					
				

				
					
						W tym momencie widzę, że jasna plama za postacią zbyt moc-
					
				

				
					
						no odwraca uwagę widza. Na nowej warstwie zamalowuję ją 
					
				

				
					
						i ostrożnie (spłaszczyłem obrazek, więc muszę uważać, aby nie za-
					
				

				
					
						malować postaci) dodaję jasną plamę za głową postaci, aby ją do-
					
				

				
					
						datkowo wyeksponować. Następnie dodaję kilka drobnych detali jak 
					
				

				
					
						zielone elementy na broszach. Jeszcze ostatni rzut oka na obrazek 
					
				

				
					
						i stwierdzam, że jest już ukończony. 
					
				

			

			
				
					
						podsumowanie
					
				

				
					
						Jak widać, malowanie postaci nie jest takie trudne. Wystarczy 
					
				

				
					
						tylko przestrzegać zasad (wspólnych w wielu przypadkach) 
					
				

				
					
						i pilnować samego siebie... trzeba jeszcze do tego dodać dużo wy-
					
				

				
					
						trwałości, cierpliwości i trochę wyobraźni. 
					
				

			

			
				
					
						Michał Bernat
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